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本取扱説明書について  
本書では、2D画像からレンチキュラー効果を作成、編集するにあたっての必要な情報が記載
されています。 

対象読者 
本書はHumanEyes Creativeユーザを対象としています。Apple Macintoshコンピュータ全般、
特にMac OS X (v10.4)に精通した、卓越したグラフィック・アーティスト向けに作成されて
います。対象読者が、Mac OS Xインターフェースのスムーズな操作が可能であることを前提
としています。 

目的 
HumanEyes Creativeの機能についてご説明し、また適切にご使用いただくためのご案内をい
たします。なお本書は「HumanEyes3D PrintPro 2.0取扱説明書」に代えることを意図しており
ません。 

表記規則 
本説明書では、以下の表記規則を用います。 
 
表記 説明 

太字 ウィンドウ名、ダイアローグボックス名は、太字で表記されています。 

Arial Arial fontはファイル名の表記、また、指示ボタンやメニュー、タブの名前
などの、クリックあるいは選択すべき事項の表記に用いられています。  

  
注 
注には大変重要な情報が含まれています。このアイコン表記が目印です。 

 
重要 
このアイコンは重要な情報の目印です。 

 
警告 
機器やデータへのダメージが考えられる場合、あるいは、結果的になんら
かの問題が生じる可能性がある場合に警告します。 

関連文書 
• 本書の記載と関連があるのは、HumanEyes3D PrintPro 2.0取扱説明書です。

HumanEyes3D PrintPro 2.0取扱説明書では、HumanEyes3D PrintPro 2.0 の機能と使用方
法について、また3D作品の製作、編集、製品化についての詳細な説明が記載されて
います。 

テクニカルサポート 
HumanEyesの正規販売代理店にご相談いただくか、以下のアドレスに電子メールでお問い合
わせください：Support@HumanEyes.com. 



   HumanEyes Creative 取扱説明書 

 イントロダクション 7 

イントロダクション 
卓越した3D作成・印刷の黄金基準、HumanEyes Creative3Dへようこそ。Creative3Dは、2D画
像からのレンチキュラー効果製作・作成の革新的ソリューションです。Creative3Dは、
cutting-edgeソリューションによって、3Dコンテンツ作成に革命を起こしました。お持ちの
2D画像コレクションを文字通り解き放つ、この新しいツールを体感してみてください。
HumanEyes Creativeは、アイキャッチを見る人々にリアルな体感をもたらす3Dを、2Dのよう
に便利かつコストパフォーマンスも効率的なものにいたしました。 

本書はすべてのHumanEyes Creative製品の使用に際して参考にすることができます。他の製
品と関連のある箇所には、このような注を設けてあります。  

本製品の特長 
 

• 2Dから3Dへの画像変換。 

• 2D-to-3D、レイヤード3D、フリップ、アニメーション等、あらゆるレンチキュラー
効果をフルサポート。 

• 元画像からの、レイヤーの範囲設定と作成から、印刷時にHumanEyes PrintPro 2.0で
開くためのLdocファイル保存まで、3D画像作成の全作業工程をカバー。 

• 作成後は名刺から、ポップ広告、ポートレート、商品包装、広告掲示板まで、様々
な用途に繰り返し利用可能。 

Creative3Dでは3D作成と奥行きのあるレンチキュラー効果が可能であり、アウトプットの際
のサイズに制限はありません。製作工程は手早くかつ簡単です。製作工程の主だった部分は
Creative3Dが自動的に処理しますが、作品のカスタマイズの完璧な制御が可能です。
Creative3Dでは、作成した多数のビューの制御、最終的な画像のサイズ、奥行き効果の制御
が可能です。 
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HumanEyes Creative3Dのインストール 

システム要件 
1. PowerPC® G4, G5 または Intel® Core™ Duo 2 プロセッサー 

2. Mac OS X 10.4.7 およびそれ以降のバージョン  

3. QuickTime 7.1 またはそれ以降のバージョン 

4. 1GBの RAM 

5. 10 MBのハードディスク空き容量（大きめのファイルの作業には最低 8GBの
空き容量が必要です）  

6. グラフィックカード 64MBのメモリ（64MB 以上推奨） 

インストール 
1. HumanEyes3D CDを CD-ROMドライブに挿入します。 

2. HumanEyesCreative.pkg.を実行し、HumanEyes Creative ソフトウェアをインス
トールします。  

トライアルウェア 
当ソフトウェアは 60日間トライアルです。スタートアップの際、以下のお知らせが表示
されます。 

 

このスタートアップ・ボックスはソフトウェアのアクティヴ化時に消えます。 
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HumanEyes Creative3Dの使用方法 

HumanEyes Creativeの起動と終了      
Creative3Dを起動するためには、Dockに表示されているCreative3Dアイコンをクリックする
か、あるいはアプリケーション・フォルダ内のCreative3Dアイコンをダブルクリックしま
す。終了するためには、 Q を押すか、HumanEyesメニューからQuitを選択します。 

Creative3Dを起動すると、次のような標準デスクトップ画面が表示されます: 

 

図1: HumanEyes Creativeデスクトップ 

HumanEyes Creative3D デスクトップで操作する 
アプリケーション起動後、上記のようなデスクトップが現れます。HumanEyes標準デスクト
ップは、次の3つの基本要素で構成されています。HumanEyesメニューバー、プロパティー
バー、そしてHumanEyesツールバーです。プロパティーバーとツールバーは、作業内容に即
して変更されます。 

 



HumanEyes Creative 取扱説明書  

10  

文書タイプ 

新規文書 
• 白紙のキャンバスから開始します。新規文書を開いた後は、どの時点でも効果を挿入する
ことができます。  

3D文書 
• 2D-to-3Dを使用して3Dに変換したい2Dファイルを開きます。 

• レイヤード3Dファイルを開きます（レイヤード2Dの単数、あるいは複数の画像の選択、
3Dイメージ作成のためのレイヤーごとの幅を指定）。 

2D文書 
• タイムラインを用いてフリップを作成したい画像を開きます（画像を赤から青にするな
ど即座に変更できます）。 

• 2D効果を作成したい画像を開きます（アニメーションでは、画像を動くボールや時計な
どとして表示することができます）。 

スペシャルボタン 
Creative3D には以下のような便利なボタンがあります:  

 
 

MarketPlaceボタンは、HumanEyes On-line MarketPlaceに簡単に入ることができる便利なボタ
ンです。Creative MarketPlaceとは、レンチキュラー作品を送付すれば、価格と所要時間の見
積を速やかに得ることができるサービスです。このサービスは無料で、独立したものです。
印刷会社を決定する準備が整う時まで、匿名性が保たれます。このサービスをご利用になれ
ば、ご自身の創作に集中しながら、時間の無駄なく、またご予算に合わせて、プロジェクト
を完成させることが可能です。 

他の2つのボタンは、HumanEyesホームページへのリンクと、Creative3Dソフトウェアに関す
る便利な情報へのリンクです。 

文書を作成する 
HumanEyes Creativeでは、2D-to-3D、アニメーション、フリップといった複数のタイプの文
書作成が可能です。HumanEyes Creativeが革新的な点は、1つの、あるいは複数の2D画像から
始められる点、また、簡単なキー打ち操作によって、レンチキュラー印刷のための3Dを得る
ことができる点です（すべてソフトウェア任せです）。効果は組み合わせ可能です（例・ア
ニメーションと3D）。白紙からの新規作成も可能です。その際には2Dと3Dの両効果を加え
ることができます。タイムラインウィンドウ機能の使用時には、レンチキュラー効果のシミ
ュレーションが可能です。この効果はアナグリフ・モードでも参照できます（3Dグラス使
用）。文書完成後のインターレース、印刷には、HumanEyes PrintPro 2.0を起動します。取り
込むことのできる画像ファイルの上限は、だいたい7000×7000ピクセルです。 
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新規文書作成 
文書作成には、ファイルメニューから新規作成を選択し、作成したい文書タイプを選びます。 

 

図2: 新規作成 

 

 

表 1: 新規文書機能 

選択されるとDocument Settings ウィンドウが現れます。 

機能 キーボード 
ショートカ
ット 

解説と使用法（いずれの場合も、まずDocument Settings ウ

ィンドウが現れ、次に OK をクリックすることで以下のように
なります） 

Blank Document N Previewモードで新規の白紙文書を開きます。上級ユーザ向け
です。 

3D Template>2D-to-3D… N Select file to open… ウィンドウを開きます。任意の2D画像を

参照し、選択してOpenをクリックします。画像は2D-to-3D 

Model window、 Layering View内の新規 HumanEyes 文書にイン
ポートされます。 

3D Template>Layered 3D… ⌥ 6 Select file… ウィンドウを開きます。レイヤーとして使用する

任意の2D画像を参照、選択しChooseをクリックします。画像
は Preview mode 内の新規 HumanEyes 文書にインポートされま
す。 

2D Template>Flip… ⌥ 3 Select file… ウィンドウを開きます。フリップでフレームとし

て使用する任意の2D画像を参照、選択してChooseをクリック
します。画像は Preview mode 内の新規 HumanEyes 文書にイン
ポートされます。 

2D Template>Animation… ⌥ 4 Select file… ウィンドウを開きます。アニメーションでフレー

ムとして使用する任意の2D画像を参照、選択しChooseをクリ
ックします。画像は Preview mode 内の新規 HumanEyes 文書に
インポートされます。 
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Document Settings 
D を押すか、または、DocumentメニューからSettingsを選択することで、いつでも

Document Settingsダイアローグボックスを開くことができます。 

  

 

図3: Document Settingsダイアローグボックス 
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Document Settings ダイアローグの機能は以下のとおりです。 

設定Setting 解説Description 

Canvas Size 文書の任意の幅と高さを設定するか、設定済みのサイズの中から
選択します。文書の方向も選択可能です。 

Width & Height キャンバスの幅と高さです。 

Depth 前景の対象から背景までのZ軸に沿った奥行きです。この推奨の奥
行きは、特定のレンチキュラーレンズと特定のレンズ幅で見るこ
とができる最大のものです。 

Constrain Proportions  
checkbox 

幅・高さの比率を固定します。このボックスにチェックを入れて
いる時に幅が変更された場合、高さは幅との比率に従って自動的
に調節されます。例：幅 10、高さ 5で、Constrain Proportionsにチ
ェックが入れられていた場合、幅を 20に変更すれば、高さは自動
的に 10に変更されます。 

Resize Contents 文書サイズが変更された時にレイヤーの大きさを変更します。
例：10x20 の文書で、レイヤーがその上半分（つまり、（0, 0）か
ら（10, 10））の場合は、Resize Contents をチェックしている状態
で、文書の幅を 10から 20に変更すれば、レイヤーは（0, 0）から
(20, 10）の範囲で半分以上に保たれます。チェックしていない
場合は、レイヤーは変更されず、文書の四分の一の範囲に留ま
ります。 

Number of Views この数値は文書内のビュー（シーンのビューポイント）の数を決
定します。 

レンチキュラーレンズ 
Type 

印刷プレビュー時に使用するレンチキュラーレンズのタイプを設
定します。 

Viewing Distance 最終的に印刷される画像の概算距離を設定します。この数値はレ
ンチキュラーピッチテストにおいて使用される距離と同値です。
このviewing distanceは文書の幅より常に大きい数値です。 

表2: Document Settings 
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HumanEyes Creative3D ツールバー 

 

図4: Creative3D ツールバー 

Rotate Scene

Zoom In

Coarse Layering Fine Layering

UnusedChange Opacity

Rotate Shape Move or Resize a Depth Object

Zoom Out

Hand Tool

Fine Layering in Selection

Add Pixels to Layer

Knife

Move Forwards/Backwards

Rotate

Unused

Remove Pixels from Layer

Unused

Plane

Depth Brush

UnusedSelect an Area

Push/Pull
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文書を見る 

文書をDocument ウィンドウで見る 

文書を見ることができるのは、メインの文書ウィンドウ（ プレビューモード、あるいは

 3Dモデルビューモード）また、2D-to-3Dモデルウィンドウ（  レイヤーリングビュ

ーモード、あるいは  3Dモデルビューモード）です。文書ウィンドウは、文書全体、ま
たはレイヤー全体（レイヤーの構成サブレイヤーではなく）への効果の適用、変更に使用し
ます。2D-to-3Dモデルウィンドウは2D画像を3Dモデルに重ね、その後で3Dモデルのサブレ
イヤーを操作する際に使用します。  

プレビュー  ボタンをクリックすれば、文書をビューの総体として見られます（これはメ
イン文書ウィンドウの初期設定ビューです）。  
2Dウィンドウでは以下のようなことができます: 

文書を3Dモデルとして見る  

 3Dモデルビューボタンをクリックすると、文書を3Dモードで見られます。 
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図5: Viewing 3D Model  

3Dウィンドウでは以下のことが可能です: 

1. Rotate Scene  ツールは 3D モデルを、モデルの軸にそって、マウスド
ラッグで回転させられます。このツールは二者択一的に作動させることが可
能です。他のツール使用時に、alt キーを押しながらマウスドラッグをします。
これらの操作により、以下の図のようになります:  

 

図6: View Point Controlsで回転した3Dモデル 

2. 以下のボタンの中のひとつをクリックすれば、モデルを異なる視点から見る
ことができます:  

 

図7: View Point Controls 

元の視点に戻したい時は、Model  View Pointをクリックします。 

3. 3D モデルを、水平方向、あるいは垂直方向に動かす時は、Hand  ツールを
クリックし、マウスのクリック＆ドラッグの操作で動かします。あるいは、ス
ペースキーを押したまま、対象をマウスで動かすという方法も可能です。 
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ズーム 

ズームインしたい時は、 +を押すか、Zoom In  ツールを選択、あるいはViewメニュー
からZoom Inを選択し、画像のズームインしたい部分をクリックするか、マウスボタンを押
してズームインしたい範囲を特定します。ズームアウトしたい時は、 －を押すか、ズーム

アウト ツールを選択、あるいはViewメニューからZoom Outを選択します。  

元に戻す 
ひとつ前の操作に戻るには、 Zを押すか、EditメニューからUndoを選択します。また、やり
直した操作を再度やり直したい時は、 Zを押すか、EditメニューからUndoを選択します。 
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2D-to-3D 
2D画像から3D文書を作成する作業手順は二段階です。まず初めに、3Dに変換した画像を用
意します。次に、完成した3Dモデルをタイムラインの一部として使用します。タイムライン
では他の効果と組み合わせることができます。新規2D-to-3D文書を作成する場合は、Fileメ
ニュー>New>3D Template>2D-to-3D…を選択し、次にレンチキュラー印刷用の3Dに変換し
たい2D画像を選びます。新規文書は、異なるレイヤーに画像を分割するレイヤーリングの準
備ができた状態で表示される画像とともに開きます。また、2D-to-3D Modelウィンドウを表
示する時は常に、Layersウィンドウも表示します。Layersウィンドウでは、the display  ア
イコンをクリックすることによって、レイヤーの表示・非表示を設定します。レイヤーが非

表示の時の目は、 の上に"X"を付けた状態 .で表示されます。さらに、 アイコンの隣
のスペースをクリックすることで、レイヤーを表示させることができます。Layersウィンド
ウはレイヤー内容のサムネールを見ることができます。 

 

図8: Layers ウィンドウ 
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図9: レイヤー化前の2D-to-3D  

 

レイヤー化 
この例では、ニモが背景から「分割」されています。 

Coarse Layering tool を選択します。このツールによって、3D文書の異なるレイヤーにあ
る領域を特定します。選択後、 Layering propertiesが表示されます: 

 

図10: Layering Properties 

このスライダで、Coarse Layering ブラシとブラシの強さを調節します。強さStrengthのス
ライダは、右に行くほど、ブラシの境界がはっきりするようになります。選択部分がレイヤ

ー化された前か後にStrengthスライダが調節されます。レイヤー化された最後の領域は、 強
さStrengthスライダの調節に従って、自動的に調節されます。Smooth Boundaries機能は、
レイヤーそれぞれの定義、分割に従って、レイヤーのエッジをぼかします。 
画像内の様々な要素の任意の境界を特定するための、強力で直感的なアルゴリズムが、
HumanEyesにはあります。上に挙げた例では、奥行きを与えるために、カラフルな背景か

2D画像から3D画像を作成する作業工程は3ステップ: 
1. Layer –画像をレイヤーに分割。 
2. Add Depth – レイヤーに奥行きを加える。 
3. Fill holes– ステップ1 とステップ 2で作成した背景holesを埋める。 
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らニモが「分割」されます。ニモを含むレイヤーと、背景の海を含むレイヤーに分けられ
るのです。 

任意のレイヤーに含ませたい画像領域を特定するのは簡単です。クリックしたままレイヤー
に含ませたい領域をマウスでなぞるだけです。見えている通りの多彩な色のグラデーション
を再現するのも良いでしょう。 

以下の図は、レイヤー化前とレイヤー化後のニモの画像です。 

 

図11: 2D-to-3D Coarse Layering – 前、後 

ブラシの跡をご覧ください。跡は残っていますが、新たにレイヤー化された領域の色が変わり、白線
で縁取りされています。画像の一部が切り離されるとすぐに、二つのレイヤーが自動的に発生しま
す。色が変わった部分が含まれているレイヤーと、他のすべてが含まれているレイヤーという二つで
す。 ツールによって特定された領域は、Layerウィンドウ内で選択されたレイヤーに自動的に加えら
れます。新しいレイヤーを作成するには、Layerウィンドウ内の何もない所で右クリックします。図の
右側に黄色い矢印で示されているように、マウスでなぞった部分が新しいレイヤーに加えられます。  

レイヤー間でピクセルや広い領域を移動させたい場合は、Add Pixels to Layer  とRemove 

Pixels from Layer  ツールを使用します。例えば、なんらかの背景レイヤーをニモに加え、
それらを取り除きたい場合は、背景レイヤーにそれらを移し戻すことができます。この操作を

するには、Remove Pixels from Layer  ツールをクリックします。このツールバーは下部にあり
ます。対象レイヤーと、使用するブラシのサイズを決めます。これで不要なピクセルを他のレイヤ
ーに移すための準備は完了です。レイヤーにピクセルを加える場合も同様の作業手順で行います。 

 

Figure図 12: Moving Pixel ツールバー 

Fine Layering Tools 
Fine layeringツールは、異なるレイヤーから複雑なピクセルを切り離す時に使用します。このツー
ルは特に、細い髪の毛や木の細枝などといった対象を扱う際に便利です。そうした対象を含む領域
は、coarse matting ツールでの切り離しは難しく、また手作業で切り離すことは大変な骨折りです。

そこで二つの素晴らしいlayeringツールがあります。Fine Layering Brush と、Fine Layering 

コメント [F1]: To create a new layer 
simply click on a blank area of the layer 
window, as shown by the yellow arrow 
on the right, and your scribbles will be 
added to a new layer. 
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Selection. です。これら二つは同様の方法で活用されます。ブラシは強いアルゴリズムをブラシ
領域に適用し、選択ツールは選択された部分に強いアルゴリズムを適用します。これら二つのツール
は、レイヤーが二つある状態で、二つのレイヤーの共通部分でのみ用いることが可能です。さらに、
これらのツールをより正確に作用させたい場合は、複雑な領域の一部ではなく全体を指定します。 

 以下のサンプルはブラシツールを髪の毛に用いる例です。 

図 13: Fine Toolsを使用する 

1 2 

3 



HumanEyes Creative 取扱説明書  

22  

1では、インテリジェントなブラシを使用後に髪の毛をレイヤー化しています。2では、ブラ
シを二つのレイヤー（背景レイヤーは非表示）の共通部分にブラシを適用しています。最後
の3では髪の毛の選択に際してのブラシツール活用の成果を見ることができます。 

レイヤーに奥行きを加える 
画像の3D変換における作業工程の二番目として、奥行きを加えます。簡単にレイヤーに奥行

きを加えることができます。3D Model View  ボタンをクリックし、変更を加えたいレイ

ヤーを選択します。Move Forwards/Backwards ツールを選択し、クリック＆ドラッグ
してレイヤーを動かします。 

    

 
 

図14: 奥行きを加えるためにレイヤーを動かす 

これでニモが水中背景の「前景」に出てきます。Rotate Scene ツールを選択すれば、文書を異な
るアングルから見ることができます。 
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3Dモデルのレイヤーを操作する際には、Forwards/Backwards ツールに加えて、以下のツールが使用
可能です。 

名前 ツ ー
ル 

解説 

Plane 
 
このツールでレイヤーの構成要素を操作します。このツールを使用することによって

3Dモードで、Rotate Scene ツールを使用し、画像がほぼ平面に見えるアングル

に動かしたときに使用します。ポインタが動かされると、線が正方形から延長され、
ボタンを離すと、もう一つの正方形がレイヤー上にセットされます。指定された領域
と一緒に画面を回転させると、二つの正方形をつなぐ線が奥行きの方向に現れます。
これで、どちらかの正方形を押すか、あるいは引いてレイヤーの奥行きを変更するこ
とができます。 

Note: 機能ボタンをクリックし、そのままにしておくと、画面を回転させるために、
アクティブなツールはRotate Sceneツールに変わります。以下の画像をご覧ください: 

 

シフトキーを押すと直線が見え、意図したアングルでレイヤーを操作していることが
確認できます。 
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Rotate    
 

 

レイヤーをx軸およびy軸に沿って回転させます。回転コイルを任意のピボットポイン
トの上に置き、ハンドルを引くだけでレイヤーを回転させることができます。 

 

 

 

 

 

 

 

 

 

 

 

  

Depth Brush 
 

 このツールは、レイヤー上のマウスを動かした位置で、奥行きをブラシで調節できま
す。パラメータはブラシのサイズ、曲度と強度です。以下の例ではニモの目が外側に
拡がっています。 

:  

Push/Pull 
 
ピクセルを引いたり押したりできます。Depth Brushよりも局所的な操作ができます。
引っ張りたい領域の強さや量を調節することもできます。 

表 3: 3D Model ツール 
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画像の仕上げ  
レイヤーに奥行きを加えたら、最後の作業工程はレイヤー化後、レイヤーに残された空白を

埋めることです。画像の仕上げは Layering Viewでの2D-to-3D modelウィンドウで行われま

す。Tools\Fill Hidden Holes機能を使って、ひとつのレイヤー、あるいは複数のレイヤーにで
きたピクセルの空白を埋めます。そのためには空白部分のあるレイヤーをクリックし、メニ
ューを使用して空白をアクティブ化します。 

    

範囲選択 

Selection Menu 機能とともにselection tool  を使用して、変更したい領域を選択できま
す。selection toolは、depth tools や layering toolsなどたくさんのツールとともに使用すること
ができます。 

selection tool を使用すると以下のようになります: 

1. Layering View  modeであることを確認します。 

2.  area（lasso） tool を選択します。 

3. 作業したい（レイヤー上の）領域を選択します。 

4. Selection Menuの中から機能を選択します。 

 

 

メニューアイテム 解説 

Select All すべてを選択 

Deselect 選択を解除 

Invert Selection 選択範囲を反転Will select the inverse of what you selected 

Expand ピクセル数に従って選択範囲を拡大 

Contract ピクセル数に従って選択範囲を縮小 

表 4：範囲選択機能 

 

Figure 2: Selection Area
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5. T
o
o
l
s
 
M

enu をクリックし、選択範囲で行う操作を決定します。 

 

 

 
結果を見る 

文書を作成、あるいは修正する間、どの段階でも、文書ウィンドウ内のPreview mode に

戻って、Timeline player controlsを使用し進行を見ることができます。Playは最終的なレンチ
キュラー印刷をシミュレーションするために、ビューを連続で展開します。 

タイムラインウィンドウで、Back  ボタンと Forward ボタンを使い、それぞれのビ

ューを個別に見ることができます。また、Play ボタンではビューの連続を前にも後にも
再生できます。 

3D効果はビューからビューへの展開における変化によって示されます。 

   
 

 

メニューアイテム 解説 

Fill Hidden Holes 選択範囲を完全に埋める 

Fill Edge of Hidden Holes 選択範囲の外側だけを埋める 

Smooth 選択範囲の輪郭のピクセルをなめらかにする 
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タイムライン  
3次元のレンチキュラー印刷作成のためには、同一の対象の、異なるポジションから単一の
画への、複数からなるビューあるいは画像の融合、また、何より、立体映像効果のシミュレ
ーションが必要です。異なったビューを捕らえることは、冗長で、時間がかかり、時に、対
象によっては不可能でさえあります。HumanEyesは、一次元、二次元の画像の操作に基づく
不在のビューを推定するという、革命的技術によって複数のビューの必要性をなくしまし
た。これらの推定された ビューは、HumanEyesにおいて、タイムラインによって提示されま
す。タイムライン内の各フレームは、それぞれの前、後ろのフレームとわずかに異なりま
す。タイムラインは（タイムラインコントロールを使用して）再生可能です。ムービークリ
ップのフレームに似ています。タイムラインを再生し、最終的なレンチキュラー印刷の外観
がわかります。二次元効果での操作を行っている場合には、タイムラインは、効果プロパテ
ィの適用と編集に使用されます。 

タイムラインウィンドウで、Back  ボタンと Forward ボタンを使い、それぞれのビ

ューを個別に見ることができます。また、Play ボタンではビューの連続を前にも後にも
再生できます。これによって最終的画像の奥行きのアイデアを得ることができるでしょう。 

レイヤーを操作する 
HumanEyesのすべての効果は、レイヤーグループに基づいています。2D効果、3D効果はそれぞれ
別々のレイヤーグループです。すべてのレイヤーはタイムラインというウィンドウに現れます。 

 

 

図 15: タイムラインとショートカットボタン 

各レイヤーはビュー（フレーム）に分けられます。ビューの数はDocument Settingsダイア
ローグボックス（Document>Settings…）あるいは Dで設定します。  
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設定 Description 

 
レイヤー追加。2D-to-3Dレイヤー（モデル）、フリップ、アニメーション
レイヤーを、2D画像同様に加えることができます。 

 移動Remove.  選択レイヤーを移動します。 

 レイヤー編集Edit Layer.  2D-to-3D Model ウィンドウを開きます。 

 レイヤー複製Duplicate Layer.  選択マスターレイヤーを複製します。 

 
レイヤーに効果を追加Add Effect to Layer.  フリップまたはアニメーション
を選択マスターレイヤーに加えます。 

 奥行きでソートSort by Depth. 文書の奥行きでレイヤーをソートします。  

表 5: タイムラインショートカットボタン 
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2D効果 
HumanEyesではアニメーションとフリップ効果を作成できます。2D効果をお互いに組み合わ
せたり、3D（2D-to-3Dとlayered 3D）モデルと組み合わせたりすることが可能です。 

タイムラインとキャンバス 

Preview ボタンをクリックして、文書とそれに対応するビューのセットを見ます。タイ

ムライン（上記参照）とPlayer Controls が自動的に表示されます。あるいは

Windowメニューから選択して表示させることができます。 

画像をインポートすると、タイムライン上に、レイヤーとして複数に分割されたビュー（フ
レーム）が表示されます。  

 

図16: 10 個のビューがあるタイムライン 

 

レイヤーが変更された時、タイムラインに変更が反映されることにご注意ください。例え
ば、以下の図では、レイヤーが大きくなり、下方右側に動かされています。 

 

図 17: 変更されたレイヤーが表示されたタイムライン 

画像のサイズ変更は、Move or Resize a Depth Object ツールで行います。このツールを選
択すると、選択されたレイヤーの座標（x, y）、幅と高さ（%）がPropertiesウィンドウに現
れます。新しい数値を入力して、キャンバス上のレイヤーの位置またはサイズを変更しま
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す。キャンバス上でマウスを使用して直接レイヤーを変更させることも可能です。3Dモデル
の個々のレイヤーを操作したい場合は、タイムライン上の対応する2D-to-3D モデルをダブル
クリックします。 

 

図 18:  Move or Resize Properties ウィンドウ 

Rotate Shape  ツールを使用してレイヤーを回転させます。このツールを選択すると、選
択レイヤーの軸ボタン（x、y、z）、スライダ、数値フィールド（Degrees）がPropertiesウィ
ンドウに表れます。対応するボタンを押して軸を選択し、スライダで調節するか、Degreeを
新規に入力して、キャンバスにおけるレイヤーの位置を変更します。2D-to-3Dモデルの、レ
イヤー全体ではなく、個々のレイヤーを操作したい場合は、タイムライン上の対応する2D-
to-3D Modelをダブルクリックします。（スクリーンショットを変更） 

 

図 19: Rotate Properties ウィンドウ 

 

図 20: 30° X 軸回転 –回転前と回転後 

 

図 21: 30° Y軸回転 –回転前と回転後 
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図22: 30° Z 軸回転 –回転前と回転後 

アニメーション作成 
アニメーション効果には、ムーヴメント、ズーム、回転、不透明度変更があります。各アニ
メーションはレイヤー下部に現れる効果として加えられます。 

 

図 23: タイムラインと効果 
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Key-Points 
どの効果でも、効果の視点となるビューと終点となるビューを決める必要があります。これ
がkey-pointsと呼ばれるものです。以下の図のように、デフォルトでは一番初めと最後のビュ
ーがkey-pointsとなっています。 

 

図 24: デフォルトKey-Points 

以下の図のように、key-points をドラッグして変更することができます。  

 

 

図 25: Key-Pointsの変更 

key-points は効果ライン上のどこにでもクリックして加えることができます。NOTE：ある
key-pointで効果を変更する前に、選択するためにkey-pointをクリックしなければなりませ
ん。選択されれば、key-pointは黒くなります。移動させるにはkey-point をダブルクリックし
ます。 

First Key Point Second Key Point 
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 図 26: Key-Points追加と選択 

 

 

 

2D効果を加える 

新しく2D効果を加えるには: 
1. 新規文書作成で新規アニメーション文書を開きます。 

2. タイムライン上で効果を加えたいレイヤーを選択します。 

3. 右クリック（ctrl+click）で Assign 2D Effect メニューを開き、効果を選択します。  

 

図 27: The Assign Effect メニュー 
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2D効果を削除する 
2D効果を削除するには、効果を右クリック (ctrl+click)し、Removeを選択するか、選択され

た効果に対して、 をクリックします。 

2D効果を編集する－ムーヴメント効果 
2D 効果を編集すると、同一の基本原則がすべての効果に適用されます。これら
の原則の説明のためにムーヴメント効果を例に取りあげます。以下のセクショ
ンでは、他の効果、つまりズーム、回転、不透明度の効果に適用する特別な事
項をご説明します。 

1. 2D 効果を加えます。そのためには二つ方法があります。Insert > Effectを選
択して新規効果を挿入して加えたい効果を選ぶか、マスターレイヤー上で右
クリック（ctrl+click）して加えたい効果を選びます。 

2. key-points を設定します。Key-Pointsのセクションを参照。 

3. 始点となる key-pointをクリックします。キャンバスにそのビューが表示され
ます。 

 

 

図 28: 最初のKey-point、始点として選択したビューをキャンバスの左中央に移動 

選択したビューに適用する効果を設定します。この例では、ムーヴメント効果を追加したので、任意
の始点に画像を移動させます。 
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key-pointsの間に挟まれたビューは、key-point 1 の位置から key-point 2の位置までの漸次的な変化を見
せるように、自動的に位置が変更されます。 

 

 

第二key-pointはまだ変更されていません。  

 

図 29: 第二Key-point ビュー – 下に移動 

図 30: 第二Key-point ビュー 

NOTE: 二つのkey-pointの間のビューは、key-point 1 からkey-point 2への漸次的な変化を見せ
るように再度自動的に更新されます。 

4. Play  ボタンを押すと、ミュージシャンが左中央（最初の key-point）か
ら右端（最後の key-point）まで動くのを見ることができます。 

5. ムーヴメント効果を選択すると、選択された key-pointの画像座標と寸法が表
示されます。 

 

図 31: Position and Size Properties ウィンドウ 

位置座標（x, y）と寸法のパーセンテージ数値を手入力あるいはクリックドラッグによって
入力します。 
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回転を編集する 
基本的には上記の 2D効果を編集する」セクションにおけるものと同じです。 

ここで異なる点は、最初の key-point が回転の始点であり、第二の key-point が回転の終点で 

 

あるということです。回転効果が加えられると、回転スライダが表示されます。 

 

図 32: Rotation Properties Window 

スライダを右に動かすと時計回りに、左に動かすと反時計回りになります。マウスの操作で
も回転を編集できます。マウスのポインタが画像のいずれかの角を通ると、ポインタの矢印
がカーブした二重矢印に変わります。その時に画像をクリックドラッグして回転の始点と終
点に設置します。 

 

ズーム効果を編集する 
基本的には「2D効果を編集する－ムーヴメント」セクションと同様です。ここでの異なる点
は最初のkey-pointが最初のサイズであり、第二のkey-pointが最終的なサイズであるというこ
とです。ズーム効果を加えると、画像の周囲にハンドルつきの線が現れます。ハンドル部分
をドラッグして画像のサイズを変更します。  

 

図 33: ズーム効果用サイズ変更ハンドル 
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不透明度を編集する 
基本的には2D効果を編集する」セクションと同様です。 

ここでの異なる点は、最初のkey-pointが不透明度の始点であり、第二の key-point が最終的な
不透明度であるということです。不透明度効果を加えると、不透明度を調節するスライダが
現れます。 

図 34: 画像に加えられた不透明度 

2D効果を組み合わせる 
文書内では2D効果を組み合わせることが可能です。例として地球の画像を使用します。ここ
ではムーヴメントとズームを組み合わせ、地球が近づくにつれて大きくなり、遠くなるにつ
れて小さくなる様子を表現します。  

 

図 35: ムーヴメント効果を加える 

Opacity 
automatically 
distributed 
throughout frames 
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キャンバス上で最初の key-point では、左手の角に画像を置きます。 

 

図36:最初のKey-Point用画像を配置する 

第二key-pointでは、右下方に画像を置きます。 

 

図 37: 第二Key-Pointを配置する 
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今度はズーム効果を加えます。 

 

図 38: ズーム効果を加える 

最初の key-pointでは、画像を縮小します。 

 

図 39: 最初のKey-Point用の画像のサイズを縮小する 
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第二key-pointでは、画像を拡大します。 

 

図 40: 第二Key-Point用の画像のサイズを拡大する 

最終的に、 をクリックした時に得られる効果は、地球が近づいてきて（右下方へ）大き
くなっていき、左上へ縮小しながら戻っていくというものです。 

フリップを作成する 
フリップ効果は2つ以上の画像を組み合わせます。見る人がどんなアングルから見ているか
によって、画像のうち1つの画像だけがその時々に現れます。  

1. File > New > 2D Template > Flip… あるいは ⌥ 3を選択して新規フリップ文
書を作成します。 
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2. フリップ効果を使用する画像の選択に移ります。ここでは開かれた目の画像
と閉じられた目の画像を使用して、まばたきする目の効果を例示します。 

 

図 41: フリップを加える 

3. フリップは、個々の「区分」として別々に分かれた画像とともに表示されま
す。以下の図では、フリップにインポートされた 4 つの画像が 4 つの部分に
分けられています。 

 

図 42: 区分に分けられたフリップ  

最初の3つの画像が2つずつのビューに分けられていることにご注目くださ
い。最後の区分は4つのビューからなっており、10個のビューが一緒になっ
ています（File > Document Settingsのセットとして）。区分におけるビュー
の数によって、その区分が表示される時間が決まります。  



HumanEyes Creative 取扱説明書  

42  

4. 区分内のビューの数は、区分を選択し、表れたハンドルをドラッグすること
で変更できます。以下の例では、４つ目の区分からひとつビューを減らして、
3つ目の区分にビューを加えています。 

 

図 43: 区分からビュー数を減らす 

 

図 44: 区分のビュー数を増やす 
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5. 以下の例のように、区分を別の位置にドラッグすることもできます。 

 

図45:区分からビュー数を減らす 

 

図 46:区分を別の新しい位置にドラッグする 

 

図 47:区分にビューを加える 
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PhotoShopでファイルを編集する 
Adobe Photoshop ©のような外部アプリケーションを使用して、画像とレイヤーを編集することができ
ます。外部アプリケーションでレイヤーあるいはサブレイヤーを編集するには、タイムラインウィン

ドウ内かlayers listウィンドウ内の任意のレイヤーを選択するか、メニューアイテムのEdit\Edit in 
External applicationを選択します。すると以下のウィンドウが表示されるので、Adobe Photoshop ©な
どの外部アプリケーションを選択します。外部アプリケーションに画像が保存されると、外部アプリ
ケーションでの編集は、Creative SW内の画像に自動的に適用されます。例えば、画像テクスチャーを
変更したり、色調補正をしたり、アルファマスクを編集したりということが可能です。 

Note：外部アプリケーションで編集する際に、Creative SWは新規レイヤーの追加についてはサポート
していません。  

 

 



   HumanEyes Creative 取扱説明書 

 環境設定 45 

環境設定 
HumanEyes>Preferences または を選択してPreferences ウィンドウを開きます。  

 

図 48：環境設定ダイアローグボックス 
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Preferences dialog の機能は以下の通りです: 

 設定 解説 

3D Background 3Dウィンドウでの背景色を設定します。 

Grid 3Dウィンドウでのベースグリッド（フロアー）の色を設定します。 

Shadow 3D Edit ウィンドウのフロアー（ベース）の影の色を設定します。 

Document Border 3D Edit ウィンドウの文書ボーダーの色を設定します。 

Selected Sub-Layer 選択サブレイヤーの色のオーバーレイを設定します。 

Intelligent Brush Intelligent Brush（course layering brush）の色を設定します。 

Fine Brush Fine Brush の色を設定します。 

Sub-layer Boundary 3D Model ウィンドウでのレイヤーボーダーの色を設定します。. 

Segment タイムラインの区分の色を設定します。 

色
 

Selected Segment タイムラインの選択区分の色を設定します。 

Automatic Save Every __ Minutes 文書のオートセーブの時間間隔を設定します。Auto Save 横のチェッ
クボックスがチェックされているときのみ適用されます。 

Default Units 文書で使用するメジャーの単位を設定します。 

Layer Boundary Thickness このスライダはピクセルにおけるレイヤーの境界線幅を設定しま
す。 

そ
の
他

 

Selected Layer Opacity 選択中のレイヤーの透明度を設定します。 

表 6: 環境設定 
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保存 
2D、3D文書を作成後は、ファイルを「ldoc」拡張子でご自身のコンピュータ内の任意の場所
に保存します。 

LdocファイルはHumanEyes® PrintPro 2.0によってインタレースおよび印刷のために開くこと
ができます。完成文書はレンチキュラー レンズで full 2D and/or 3D 効果 を与えて見ることが
できます。 

 

図 49:レンチキュラーのもとで見る完成画像 
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Thank you for using HumanEyes Creative3D 

http://www.humaneyes.com 


